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Overview

OPC UA [Open Platform Communications Unified Architecture] is a machine to machine communication
protocol designed for use in the Industrial Automation industry. OPC UA features cross-platform
interoperability, unified access, standardized communication, and security. In this environment, the cMT
series with a built-in OPC UA server plays a key role as a Communication Gateway allowing OPC UA
clients to access HMI or PLC data by subscribing to tags to receive real-time updates.

Supported cMT Devices:
e cMT3000 models (currently cMT3070, cMT3090, cMT3103, & cMT3151)
e cMT-SVR models (currently cMT-SVR-100, cMT-SVR-102, cMT-SVR-OPCUA, & cMT-HDMI)
e cMT Communications Gateway models (currently cMT-G01 & cMT-G02)
Note: A one-time license fee is required for cMT-SVR-100, cMT-SVR-102, & cMT-HDMI units.
Minimum Software Requirements:
e EZwarePlus V5.05.01 or later
e EasyBuilderPro V6.01.01 or later
Recommended OPC UA Client:
e Indusoft Web Studio

Maple Systems HMIs and OPC UA

In the following example of an OPC Unified Architecture, we are running Indusoft Web Studio as our
SCADA software on a Maple System Light Industrial Panel PC. The Panel PC is the OPC UA client and is
used to access data in the OPC UA Server, running on a supported cMT device, to receive data updates
from any of the PLCs connected to the cMT HMI. No additional Web Studio drivers required.

OMI6821A
Light Industrial
Panel PC

OPC UA Client

OPC UA Server OPC UA Server
cMT-SVR-OPCUA cMT3151
-
"
L]
B Mitsubishi Siemens 5 5 |
OMRON Rockwell l
:l Toshiba Schneider r[[[[ {
° |
FATEK L A
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EZwarePlus Settings

In an EZwarePlus cMT project, from the top menu bar select lloT -> OPC UA Server to open the OPC UA
Server options.

Server Settings

e Select the Enable check box to open the OPC UA Server settings dialog box.

e Enter a name for your OPC UA Server into the Comment field.

You may leave the rest of the settings at their defaults. EZwarePlus provides the relevant system tags

needed to monitor and control the server in the dialog box.

OPC UA Server

Enable

5
OPC UA Server % |
General | User Authentication
Comment: cMT5151 OPC UA Server
OPCTCP
opc.tep: ff<HMI IP=:4840/
Port: 4340
Server name :
Security policy : MNone
Basic128Rsal5 Sign; Sign & Encrypt -
Basic256 Sign; Sign & Encrypt -
Basic2565ha256  |Sign; Sign &Encrypt -
‘You can use the following OPC UA system tags :
LW-11435 (16hit) : OPC UA status (0: stopped, 1: running)
LW-11436 (16bit) : OPC UA error code (0: success, 1 or more: error)
LW-11437 (18bit) : OPC UA control command {0: none, 1: start, 2: stop)
*If timestamp in OPC UA is incorrect, please check your time zone setting in [System
Parameter Settings].

OPC UA Server Setup Overview
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The User Authentication tab is used to select an authentication method when the client logs in. Browse,
Read, and Write permissions can be granted to Anonymous logins or restricted to users with a username
and password. Usernames and passwords are specified on the Security tab of the System Parameter
Settings (from the top menu bar select Edit -> System Parameters). These settings apply globally to all
tags available to the OPC UA client. Access can also be restricted at the individual tag level when adding
tags to the server as described below.

Click OK to create the OPC UA Server.

OPC UA Server
:-Generai"i"USer Authentication |
| Methods
OPC UA Server =
V] Anonymons
[¥] Enable [¥] Browse
[¥] Read
[ Wreite
[V] zer name & passwond
T e—
T
* Edit user accounts in [Becurity] of [System Parameter Settings].
| Exit
OK | | Cancel Help |
Creating Tags

Once the OPC UA Server has been created, tags can be added. The client program can browse these tags
to monitor and control the automation system through the OPC UA Server.

e C(Click the New Tag button to specify a new address to add to the OPC UA server.

e The New group button is used to create a new node in the tag list under which tags can be
added. The structure of the tag list created here will be visible when configuring the OPC UA
client.
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As shown in the following screenshots, Mixer Status is configured as readable bit address while Mixer
Start_Stop is both a readable and writable bit address.

Enable

Name :  Mixer Status|

=+ Local HMI

7 Tags

@ Bit

Address
PLC: [Local HMI

Address: |15 [0

Type

Readable Wiritable

Enable

Server

>
Settings... | Settings

Tag MName : Mixer Start_Stop

£ Local HMI
ED Tags

- H Mixer @ Bit

- Mixer

Address
PLC : (Local HMI

Address : [Lg -1

Type

Readable Writable

Similarly, Last Alarm and Current Alarm are read only word addresses underneath the Alarms grouping.

Enable
Server
Settings...

Tag
=+ Local HMI

New group...
New group... )
il Mixer Start_st{| ag...
-l Mo Status 0ld name :

Settings...

New name : Afarms
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Enable

Server

.
Settings... | Mew Tag

Tag Name :  Last Alarm =
B Local HMI New group...
E!-D Tags
e[ Alarms| OBt
- m Mixer

S Mixer § | Address
PLC : [Local HMI | [ Setfings..._|

Address: L -0 [16-bit Unsigned(

Type

Readable Writable

[ o J[ conca

Enable
Server
Settings...

Tag

=[] Local HMI HNew group...
EI-D Tags
=] D Alarms
¢ ~/l Current Alarm
¢l Last Alarm
i [H Mixer Start_Stop
-l Mixer Status

The addresses that can be monitored and controlled are not limited to Local HMI addresses; PLC
addresses can be added as well.
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Downloading the Project

When downloading the project file to the cMT unit, you must make sure that the time and time-zone
settings are correct. Otherwise, the client program may not be able to authenticate, and communication
may fail due to an authentication error caused by an incorrect certificate valid time. If this happens, the
only solution is to restore the cMT’s settings to default.

=
System Parameter Settings =
‘ Device | Madel I General | System Setting | Security I Non-ASCII Fonts Font Mapping |
Extended Memary Time Sync. /DST ‘ e-Mail | Redpes Cellular Data Netwark
HMI time zone :  {UTC-08:00) : Pacific Standard Time -

[ Enable time synchronization via NTP (Metwark Time Pratocol) server

Automatically set daylight saving time (DST)

Start : [March ~|(second +] [suncay =] zo0am 3

End : [November ~ [First ~ [sunday =] [pzooam

Daylightbias : p1:0p 5 | (00:30 ~ 12:00)

*HMI enters into DST period when LB-12355 {read only) is ON.
*Use LW-11260 ~ 11272 to modify settings on HMIL.

*DST is not supported in on-ing simulation.
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Web Studio OPC UA Client Configuration
Indusoft Web Studio

Web Studio can be run on any of Maple Systems’ Light or Heavy Industrial Panel PCs. If you are new to
Web Studio, you can download the development software here:

Download Link

Web Studio will run as a full unlocked version for 40 hours before it must be licensed. You can find a
number of videos and documents on the Indusoft website on how to set up OPC UA clients and servers:

http://www.indusoft.com/Marketing/Article/PID/684/CategorylD/127/CategoryName/OPC

This overview will walk you through creating a simple Web Studio test project to act as an OPC UA client
and connect to the cMT project created in EZwarePlus as described above.

Web Studio Project Set Up

Before setting up the Web Studio project, the EZwarePlus project must be downloaded to a running cMT
device. The cMT unit must be accessible on the same Local Area Network (LAN) as the machine running
the Web Studio development tools to ensure that the tags created on the cMT device can be discovered
by the Web Studio application.

r Ik
New XS
w_ 'J /\] Create new Project with the specified settings
File
Project name

OPC_UA_Chent_Exampls

Location;

ClUsers) ‘\DocumentsWWonderware induSoft Web Studio vE.0 Propects\ Browse
Configuration file:

CAlsars ‘Documents\WWonderware InduSoft Web Studico v8.0 Propects\OPC_UA_Chent_Exam
Target platform®: () -
Product type™
[Windows Advanced Server Plus Windows Operator Workstation Plus Embedded Standard
Windows Advanced Server Windows Operator Workstation Windows Lite Inferface P
Wingdows Contrgl Room Embedded Professional Emipedded Lie Plus
Windows Control Room Lie Windows Local interface Windows Lite Interface

i [T] [}

Professional for Windows Embadded (2000 tans

*Select Windows target platform for Windows Server/Deskiop projects. Select Embedded target
platferm for Windows Embedded and bTView projects (Windows Embedded Compact (Windows CE),
¥Windows Mobde, Linu, ViWorks, elc.)

"ou can modify the target platform and preduct type after creating the projact by using the Project tab.

ok ][ caea ]|
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Create a new Web Studio project. To configure the OPC UA client click the communication tab at the
bottom of the project explorer window:

OGlobaI EGraphics ﬁTasks E%Cnmm

Expand the OPC UA folder in the project tree and right click the Connections folder to insert a new

connection:
Project Explorer
4 ’\1 Project: OPC_UA_Client_Example.APP

. Drivers
oy, OPCDA205
4., OPCUA
P Connection
i), Redundanc Insert
. TCR/P
Server Configuration £
Connection Name:
Settings
End paint: E]
User Name:
Password:
Time out: 1000 ms e
Advanced...

\,

In the Server Configuration window enter the Connection Name and End point. The End point should
match the entry under OPC TCP in the OPC UA Server settings window in EZwarePlus with the cMT
device’s actual IP address replacing the <HMI IP> field:

OPC UA Server

e B
Server Configuration ﬂ General |User Authentication

Connection Name:  cMT5151 OPC LA Server Comment : dMT5151 OPC UA Server
Settings OPC TCP
End paint: o tep://192.168.100.100:4840/cMT5151 H 0pc. bep:/ <HMI IP >:4340/cMT5151
User Name: Port: 4340

Password: Servername :  gWT5151

Timeout: 1000 ms Security palicy : [¥] Nane

@eosic2ss
Test Cormection 7] Basic2seshazss

‘fou can use the following OPC UA system tags :
LW-11435 (16bit) : OPC UA status (0: stopped, 1: running)

LW-11436 (16bit) : OPC UA error code (0: success, 1or more: error)
LW-11437 (16bit) : OPC UA control command (0: none, 1: start, 2: stop)

* If timestamp in OPC UA is incorrect, please check your time zone setting in [System
Parameter Settings].

OPC UA Server Setup Overview
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If anonymous access is restricted, a User Name and Password must be entered that matches one of the
accounts set up in the security tab of the System Parameter Settings window in EZwarePlus (Edit >
System Parameters > Security). If anonymous access is unrestricted, make sure that write access is
allowed in the OPC Server settings in EZwarePlus.

Once the End point is entered, the Test Connection button can be used to check the connection to the

cMT unit:
S

OPC

"-.I Connection established successfully te the server cMT5151 OPC UA
W' Server.

Click OK to exit the Server Configuration window.

The cMT connection should now be listed under the Connections folder in the project tree:
Project Explorer a X

a-Ya Project: OPC_UA_Client_Example. APP
----- | Drivers
----- |, OPCDAZ05
-1, OPCUA
-« |, Connections
. L.3® cMT5151 OPC UA Server
-, Redundancy Group
L2 1
----- |, TCRAP

Right click the OPC UA folder in the project tree and select Insert from the context menu. This will open
an OPC UA client driver sheet:

Project Explorer o x
4 Project: OPC_UA_Client_Example.APP

W UACLOOZ.UA X

‘|, Drivers Description:
i, OPCDA205
ap), OPCUAL Connectior:
oo -
AN WITSIST OPT UA Server
. Redundancy Group Status: Status Message:
E 1:
| TCR/IP Publish rate: [ms]: Dizable:

OPC UA Server Setup Overview
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Tag Mame
', Filter text

Scan
QL qan -t

Always -

Browse Path
', Filter text

Always -
Always -
Always -
Always -
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Select the cMT entry from the Connection dropdown list.

In the Tag Name column of the driver sheet, enter a tag name to use for the first tag. This is the name of

the tag in the Web Studio project.

If no tag with the entered name exists, a popup window will allow a new tag to be created. Make sure
the tag’s data type matches the data type of the tag in EZwarePlus.

(3]

Mew Tag -
M ame: Mixer_Status
Question — e Array: 0
Tope: [Euulean -
A% Tag 'Mixer_Status' d t exist, -
| | ag VIEr_Stalls coes ot &x Description:  Mixer Status from HMI
" Would you like to create this tag 7

Double click the Browse Path column of the driver sheet. A browser window will appear. The tag will be
located under the Objects > Local HMI > Tags folder. Any other groups created on the HMI will be
available under the Objects folder, as well as tags containing information about the HMI:

o
2K UA Browser

[S55=)

5| UA Serverl Root )
> ), Miews
4 |, Objects
> % Server
4 %z Local HMI
4 ¢ Tags
[ Mixer Start_Stop
[ Micer Status
» “ig Mams
> % HMI info

Selected kem: /0:Objects/2:Local HMI/2: Tags/2:Mixer Status

Variable

Element Type:

Data Type: Boolean
Node Id: ns=2:s=Local HM| Tags Mixer Status
Value: false

Amay Element:

OPC UA Server Setup Overview
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Select the desired tag and click OK. The selected path will be added to the driver sheet. Repeat this
process until all desired tags are added to the driver sheet.

Tag Name Browse Path Scan Div | Add | Node Id
Q Filter text Q. Fitter text Qo v Qritertet | Fittertert | Filter text
1 Wixer_Status 10:0bjectsiZ:Local HMI2:Tags/2:Mixer Status Always - ns=2;s=Local HMI. Tags.Mixer Status
2 Mixer_Start_Stop 10:0bjectsiZ:Local HMIF2:Tags/2:Mixer Start_Stop Always - ns=2,s=Local HMI. Tags.Mixer Start_Stop
3 Current_Alarm 10:0bjectsi2:Local HMI2: Tags/2:Alarms/2:Current Alarm Always - ns=2;s=Local HM|. Tags.Alarms.Current Alarm
4 Last_Alarm 10:0bjectsi2:Local HMII2:Tags/2:Alarms/i2:Last Alarm Always - ns=2;s=Local HWI.Tags. Alarms LastAlarm
5

Now these tags may be used in the Web Studio project. A simple test screen can be created and run on
the OPC UA Client PC to connect to the cMT OPC UA Server.

OPC UA Server Setup Overview 13
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Licensing a cMT-SVR/cMT-HDMI

To use the OPC UA Server feature on cMT-SVR-100, cMT-SVR-102, and cMT-HDMI models, you must
purchase a license for each device. This is a one-time purchase that is valid for the life of the product.

Note: cMT3000 and cMT-Gateway products do not require an additional license. The cMT-SVR-OPCUA
comes with the license already installed.

To purchase the license, please contact Maple Systems sales support at 1-425-745-3229 or email us at
sales@maplesystems.com.

After you have purchased an OPC UA license, you will receive a document from Maple Systems that
contains the license serial number and activation code. You must download this information to the
target cMT device using EZwarePlus/EasyBuilderPro, in order to activate the license. This download only
needs to happen once.

Steps to activate OPC UA Server license on a cMT-SVR or cMT-HDMI:

1. Getthe document you received from Maple Systems which contains the license serial number
and activation code.
Example:
Product Name: cMT-SVR
License Serial: OPCAXXXXxx
Activation code: 1234-1234-1234-1234

2. Retrieve the Hardware key from the cMT device. To do this, connect your cMT-SVR or cMT-
HDMI to your local Ethernet network and start your web browser.

3. Type http://<HMI IP Address>/ into the URL address bar.
Note: The default IP address for the LAN2 port is 192.168.100.1. The LAN1 port defaults to
DHCP. For more information on how to configure your cMT device, please consult the cMT
Quick Start Guide (P/N 10101026).

4. The Hardware key is located on the EasyAccess 2.0 page:
—lolxi

CloudHMI Server x

&) @ 192.168.100. Yweb_rmi/RAphp c‘@"GWD‘E P| wBe ¥+ #

identity: Logout % RMI5010 2014/11/06 > 01:47:20 pm
Systetrr"l( Setting

Network EasyAccess 2.0

Date/Time -
EasyAccess 2.0  Proxy
HMI Name

HIStory Account:

Email
Password:

Project
Management Hardware key: HIMIIEAY-4BGK-VPNI-CKNU-YDYP-EHTBSHLN
System Password Detect activation status

Enhanced
Security

"4 EasyAccess 2.0

OPC UA Server Setup Overview 14
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5. Go to https://account.ihmi.net/opcua/activate.php to activate:

Activate OPC UA Server(cMT-SVR)

Hardware Key:

Activation Code:

6. Type in the Hardware Key and the Activation Code. Then click the Activate button.

Activate OPC UA Server(cMT-SVR)

Hardware Key:
ALAAAAAAA MMM AANA-AAAA-AAAA-AAARAAANA
Activation Code:

PEBK-QRMS-4TXT-3LCY

===

7. A confirmation window displays with the information above listed. If the information is

8.

accurate, click the Yes, activate button.

Please confirm the imformation below.
Once the activation code is used. it cannot be undone

Hardware Key AAAAAAAA-AAAL-AAMA-AAAA-AAAA-AAAAAALA

Activation Code: PBBK-QRMS-4TXT-3LCY

Note: Once this step is completed, the activation cannot be undone.
The cMT-SVR or cMT-HDMI identified by the hardware key is now activated. But to use the OPC

UA feature on the cMT device, we must download the “opcua.lic” license file to the cMT device.
Click the Download License Key button to save the “opcua.lic” file to your computer.

OPC UA Server Setup Overview 15
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Successfully activated!
The license key for you HMI can be download below.

Hardware Key: AAAARAAA-AAAA-AAAA-BAAA-AAAA-AAAAADAA
Activation Code: PBBK-QRMS-4TXT-3LCY

Status Activated

Download License Key

Note: The license key is non-transferrable and valid only for the cMT device with the same

hardware key.

9. Your browser may block your download because of a new pop-up window. If so, follow the
browser’s instruction to allow ‘account.ihmi.net’ to show pop-ups so that you can download the
file. For example, if using Google Chrome, simply click the icon on the right of the URL address
bar, and then click the blue link from the dialog:

Guest

= o X

speua/activate.php & Pop-up blocked

The following pop-ups were blocked on this page:

O httes//accountihminet/opcus/i g s

Always allow pop-ups from https://account.ihmi.net

@) Continue blocking pop-ups

Click here first

Manage pop-up blocking Done
L_|\‘ W . [o= ]
1

henhere

Successfully activated!
The license key for you HMI can be download below.

Hardware Key AAAAAAAA-AAAA-AAAA-AAAA-ARAA-ARAAAAAA
Activation Code: P8BK-QRMS-4TXT-3LCY

Status Activated

Download License Key

10. You can now transfer the downloaded opcua.lic license file to the cMT device using EZwarePlus.
a. Start EZwarePlus and open your cMT project.
b. Click Tools->Download to display the Download window.

OPC UA Server Setup Overview 16




OPC UA Server Setup Overview 17

c. Check the Use OPC UA license option and link to the opcua.lic file you downloaded:

Download 2 &J
@) Ethernet Password Port no. of downloadfupload :
4 P HIMI Mame b
IP: 192.168.1001 hd

What's my IP?

¢ |¥]Use OPC UA license C:\Maplesystems\EZPlus'BACKUR \opoua. lic =

["|Reset recpe [ Reset eventlog [ Reset data sampling
[T|Reset recpe databass [ Reset operation log [ Reset string table

Automatically using current settings to download after compiling

d. Click the Download button.

You are now able to enjoy the features of OPC UA Server on your cMT-SVR or cMT-HDMI. The license file
only needs to be downloaded to the unit once before use, unless you reset your unit to factory defaults.
If you lose your opcua.lic file, you can go back to the activation website page
(https://account.ihmi.net/opcua/activate.php), enter the hardware key and activation code, and re-
download the license key again.

If you are experiencing difficulties getting the OPC UA Server to operate, verify that the cMT device is
activated:

e Place a Numeric Display object addressed to LW-11436 on a cMT project screen. Enable the OPC
UA Server function in the project.
e Download the project to the cMT unit and read the value.

o Ifthevalueis 0 or 1, the OPC UA Server feature has been successfully activated.

o Ifthe value is 2, the OPC UA Server feature is not activated. Verify that the license key
file has the same hardware key as the cMT device you are activating. Try downloading
the license key file again. If the OS of the cMT device has been updated, or the unit has
been reset to factory defaults, the license key file may need to be downloaded to the
cMT unit again.

If you are still experiencing difficulties, please call us or send an email to support@maplesystems.com.

OPC UA Server Setup Overview 17
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References:

OPC UA Security-How It Works:
https://opcfoundation.org/wp-content/uploads/2014/08/11 OPC UA Security How

It Works.pdf

OPC Support General Information:
https://wikis.web.cern.ch/wikis/display/EN/General+Information
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